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DFAIT SPECIFICS  - BEFORE THE MIGRATION 

Print your ICONDESK Aliases 

Your ICONDESK aliases will not be migrated. To recreate your 
address lists after your workstation migration, you may wish to 
Print your ICONDESK aliases. 

To print your ICONDESK aliases: 

1. Load ICONDESK. 
2. From the Options menu, choose Alias. 
3. From the Alias window, click one Alias. 
4. Click the View button. 
5. Click Print. 
6. Repeat steps 3 to 5 to print additional aliases. 

Note: The Internet addresses contained in your ICONDESK aliases 
will be migrated and saved on your H: drive in a file called L., alias.csv. To import these addresses in Outlook 98, lookup 
Import your ICONDESK Internet addresses in this guide. 

Netscape Bookmarks 

After your workstation migration, your Netscape bookmarks will 
be available to you from a CD or your D drive. You will need to 
use the Windows NT Find feature in order to retrieve them. If 
you prefer saving your boolcrnarks file before the migration, save 
it to the 11 drive. 

To save Netscape boolunarks to your II: drive before the 
migration: 

1. Load Netscape. 
2. From Netscape menu bar, click Boolunarks / Go to 

Bookmarks. 
111 	 3. From the Bookmarks window, select File / Save As (the Save 

As dialogue box appears). 
4. Select the H:\  drive. 
5. Click on Ok. (If you want to save bookmark.htm under a new 

name replace bookmark with another name but keep .htin for 
the extension. Ex: dfait.htm, mary.htm, john.htm, etc) 

__111 



DFAIT SPECIFICS - BEFORE THE MIGRATION

Print calendar Appointments before Monday morning

Although a migration is planned for your Lotus Organizer
Calendar, you may want to print your Calendar appointments
before the migration.

Think of a new password

On Monday morning you will be prompted to change your
password once you login. In order to save time, think of your
new password before Monday. Your password requires a
minimum of 8 characters and 3 out the 4 following criteria:
uppercase characters, lowercase characters, numeric
characters and other symbols.

2



DFAIT SPECIFICS - MONDAY MORNING 

Login in 

Follow the steps handed to you on the Welcome sheet. If you 
encounter any problems, ask your SA for assistance. 

Accessing your mail 

On Monday morning, you will be using a version of Outlook for 
Windows 3.11 or Windows 95. 

The Windows 3.11 version of Outlook will display a sealed 
envelope with bold text for an unread message and a sealed 
envelope with normal text once for a message which have been 
read. 

Until your workstation migration is completed, please follow 
these steps to work with Outlook mail. 

To access your mail: 

1. Open the Mail/Courrier Group (unless otherwise specified by 
implementation team). 

2. Double-Click the Outlook icon. 

- 
To view your ICONDESK Messages (last 2 weeks): 

- 	 1. Click the + of the ICONDESK Mailbox. 

"1 	 2. Click a folder (your ICONDESK folders are all in 
• 	

UPPERCASE). 
3. Double-click a on a message. 

NOTE: your ICONDESK messages will not display a name in the 
FROM field. The originators of all ICONDESK messages appear 
first in the TO field in [square brackets]. Example: 

TO: [John Smith SXR]; Jane Brown SXR 

To read new (Outlook) messages: 

1. Click your Personal Mailbox folder (will have your name). 
2. Click the Inbox folder. 

-"3 	 3. Double-click any message. 

'1 
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DFAIT SPECIFICS - MONDAY MORNING

4. Read the message.
5. Click File/Close to close the message window.
6. Repeat until all new messages have been read.

NOTE: if you have new messages your Inbox will be in bold and
the number of unread messages will appear in brackets).
Example: Inbox (3) means that you have 3 unread messages in
yourInbox

To reply to a message:

1. Open a message sent to you.
2. Click Compose\Reply.
3. Complete and send the message.

To send a new message:

1. Click Compose\New Mail message.
2. Click the TO button.
4. Enter the recipient's last name.
5. Double-click the recipient.
6. Click OK.
7. Type a Subject.
8. Type a message.
9. Click File\Send.

To view sent messages:

1. Click the Sent Items folder.
2. Double-click any message.
3. Click File\Close to close the message window.

To print a message:

1. From the message window, click File\Print.
2. Click OK.
3. Close the message.

Sending to OGD recipients

Until your workstation is migrated you will need to copy and
paste OGD recipients from Netscape to Outlook.

4
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DFAIT SPECIFICS - MONDAY MORNING 

To copy and paste OGD addresses from Netscape to Outlook: 

1. Load Netscape. 
2. From the DFAIT Intranet homepage, click the Directories 

Link. 
3. From the Directories page, click the Other Government 

Departments (OGD) link. 
4. From the Other Government Departments' page type the last 

name of your OGD recipient and the department acronym (if 
you have it). 

5. Click on Search. 
6. Click the OGD recipient's name from the Search results list. 
7. Select the full address in the EXCHANGE field by clicking 

and dragging. 
8. Right-click the selected address and select Copy. 
9. Load Outlook and prepare a new message. 
10.Right-click the TO field and select Paste. 

Once Windows NT is on your desktop, you will have access to 
the LDAP list from Outlook. For more on using the LDAP list, 
lookup OGD in this Guide. 

5 



DFAIT SPECIFICS - AFTER THE MIGRATION

Windows NT, Outlook 98 and the SIGNET 2000+ software suite
will be available on your desktop once your workstation
migration is completed.

Windows NT Login and Logout

Please familiarise yourself with Windows NT login and logout
procedures in this guide.

Retrieving bookmarks saved to the H drive

If you saved your bookmarks on your H drive you will need to
open your bookmarks file from Netscape.

To open your bookmark file from your H: drive after your
workstation migration:

1. Double-click Netscape icon from your desktop.
2. From Netscape menu bar, click Bookmarks button, click Edit

bookmarks.
3. From the Bookmarks window, select File / Open bookmark

file.
4. Select the H:\ drive.
5. Double-click your bookmark file on H: drive.

6
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DFAIT SPECIFICS - SECURITY 

Information designation and classification on SIGNET 2000+ 

SIGNET 2000+ is an Unclassified and Protected A network. 
Information which is Protected B, C, Confidential or Secret may 
be processed only on worlcstations designated for that purpose 
(i.e. SIGNET -C4) and the documents so processed may be stored 
only on designated floppies and in secure storage locations. 

Installing Software on SIGNET 2000+ 

On SIGNET 2000+ any installation should be done in 
conjunction with your SA. 

SIGNET 2000+ User Access 

SIGNET 2000+ users will be able to access their account from 
any SIGNET 2000+ workstation in the world using the above 
procedure. However, when visiting SIGNET-D/icoNDEsK sites, 
SIGNET 2000+ users will need the assistance of a Local SA to 
login to their account. 

To Login to SIGNET 2000+: 

1. Turn SIGNET 2000+ workstation on. 
2. Press CTRL+ALT+DELETE when prompted to do so. 
3. Click OK. 
4. At the login prompt, enter your username (unless it is already 

entered). 
5. Enter your password. 
6. Click OK. 

To Logoff SIGNET 2000+: 

1. Press CTRL+ALT+DELETE. 

2. From the Windows NT Security dialog box, click the Logoff 
button. 

3. Click Ok. 

7 



DFAIT SPECIFICS - SECURITY 

SIGNET 2000+ Passwords: 

1. Passwords must be changed every 90 days (A password may 
be changed again 1 day after it was created). 

2. Passwords must contain any three of the following four 
characteristics: an uppercase letter, a lowercase letter, a 
number or a special character (#, !, ?, 	*, etc.) 

3. Passwords may not be shared. 
4. Your last 8 passwords cannot be reused. 

To change your SIGNET 2000+ Password: 

1. Press CTRL+ALT+DELETE. 
2. From the Windows NT Security dialog box, click the Change 

Password button. 
3. Enter your current password in the Old Password field. 
4. Enter your new password in the New Password  field.  
5. Enter your new password in the Confirm New Password field. 
6. Click OK. 

Security workstation Lock 

SIGNET 2000+ workstations will automatically lock after 15 
minutes of not being in use. 

To Lock your workstation: 

1. Press CTRL+ALT+DELETE. 
2. From the Windows NT Security dialog box, click Lock 

Workstation button. 

To Unlock your workstation: 

1. Press CTRL+ALT+DELETE. 

2. Type your password. 
3. Click OK. 
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DFAIT SPECIFICS - SECURITY  

To Shut Down your workstation: 

Iii 1.  Press CTRL+ALT+DELETE. 

2. From the Windows NT Security dialog box, click the 
ShutDown button. 

3. Select the ShutDown option. 
4. Click OK. 
5. Turn Off workstation when prompted You May Turn off your 

Computer Now. 

To access Task Manager: 

1. Press CTRL+ALT+DELETE. 

2. From the Windows NT Security dialog box, click the Task 
Manager button. 

To run a VirusScan on a diskette: 

1. Insert a diskette in A:\.  
2. Click the Start button. 
3. Click VirusScan Diskette A. 
4. Close the VirusScan window when completed. 

Automatic workstation Virus Scan 

A workstation Virus Scan runs daily at 12:30PM. Your 
workstation will experience some performance penalties during 
the scan. You will also be unable to log off the workstation in the 
normal manner while the scan is in progress. 

Diskettes and Security 

The security of the data on a floppy disk is entirely dependent on 
where you choose to store the diskette. The data is only as secure 
as the physical location where the diskette is stored. Floppy disks 
are susceptible to their environment (paper clips, dust, scratches) 
and can be easily damage, thus becoming permanently 
unreadable. 

9 
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DFAIT SPECIFICS - SECURITY 

D:1 drive Backup and Security 

Since the D:\  drive is not backed up by the system, there is a risk 
of data loss in the event of a hard disk failure on your 
workstation. In the event of a workstation hard drive failure, the 
System Administrator will offer "best efforts" at recovering lost 
information. Often recovery is not possible. 

H:1 drive Backup and Security 

The H:1 drive offers two major advantages. Automatic backups 
are performed by the system on a rigidly-defined schedule. Only 
the system administrators have access to your H:\drive  and the 
network servers are located in a restricted-access facility. Lost 
or accidentally deleted files can usually be recovered, albeit as 
the previous day's version. Backup copies are not retained 
permanently and do not form part of the corporate record keeping 
system although they may be deemed to be of corporate value. 

I:1 drive Backup and Security 

The I:\  drive has the same backup and physical security 
advantages as the H:\  drive. Lost or accidentally deleted files 
can usually be recovered, albeit as the previous day's version. 
Bacicup copies are not retained permanently and do not form part 
of the corporate record keeping system although they may be 
deemed to be of corporate value. Due to its shared nature, 
documents are subject to viewing and alteration by other users. 
The I:\  drive is not suited to long-term or private storage and is 
not intended for documents of a sensitive personal nature. It must 
not contain the only copy of an official document. 

Outlook Mailbox Backup 

There is a backup of your Personal Mailbox. Items deleted from 
the Deleted Items folder are not backed up. 

Public Folders Backup 

Public Folders and their contents are backed up on SIGNET 
2000+. 
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DFAIT SPECIFICS - INFORMATION MANAGEMENT

Information should be organised in the context of departmental
and system operations

• Efficient management of electronic information is essential to
prevent corporate memory loss

• By law, all corporate information belongs to the Crown

Personal Information

Personal documents are those worked on and used by one person
only. They may have been created by the user or received from
an external source and do not affect the work of anyone else in
the division or department.

Personal documents may include:
• meeting notifications;
• a reference copy of information;
• personal notes on status of current work;
• timetables;
• job applications;
• communications analogous to an informal telephone call.

These documents have the lowest corporate value but it is
important to remember that any given record may move from a
lower to a higher category of importance to the department over
time or because of a change in circumstances.

Workgroup Information

Workgroup documents are those documents worked on, or used
by, one or more persons for programme activity purposes. They
may have been created within the workgroup or received from an
external source. The documents are stored in a shared
environment because of the high level of input and the need for
shared access. The documents are managed by the workgroup.

Workgroup documents include:
• drafts of documents that the group is finalising;
• copies of frequently referenced information;
• template documents;
• address lists;

11



DFAIT SPECIFICS - INFORMATION MANAGEMENT

• staff lists;
• staff meeting agenda and minutes;
• work practices and procedures for the group;
• organisational arrangements of the workgroup;
• administrative information;
• periodic reports.
These documents have substantial if sometimes short-term value
to a division or workgroup and their management should be
considered as more akin to corporate than personal documents.

Corporate Information

Corporate documents are prepared for or on behalf of the
department. They record the substantive programme activities
and policies of the department. Corporate documents are the
documents that are required for use by others or affect the work
of others. Depending on security requirements, these documents
should be readily accessible by those who need to use them.

Corporate documents include:
• any information reflecting the substantive business of the

department;
• final versions of reports;
• policy documents;
• formal communication between users, agencies or

organisations;
• formal minutes of departmental committees.

The identification of corporate information is very important.
This involves the identification of records created and received
by the department so their management and disposal can be
standardised and streamlined. Corporate documents are
controlled by departmental records management procedures and
stored for corporate access.

Electronic corporate information must be sent to CATS via e-
mail for storage in the corporate database and paper documents
sent to a BICO/LISO or mission records office for inclusion in
the departmental filing system.

12
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DFAIT SPECIFICS - INFORMATION MANAGEMENT 

Local Floppy Drive - A:1 drive 

A:\  drive should be used to store: 

• backup, personal, Unclassified or Protected A documents 

) 	• Unclassified or Protected A documents requiring portability 

--_) 
Local Hard Disk Drive - C: drive 

With this release of SIGNET, your local C:\  drive is no longer 
available to you for information storage. SIGNET operating 
system files are stored on the C:\  drive. 

Local Hard Disk Drive - D:1 drive 

The D:\  drive on your SIGNET workstation is available to you for 
file storage. You are responsible for the organisation and 
maintenance of information stored there. Your D:\  drive should 
be used to store back up copies of current critical documents or as 
the destination drive for any Internet downloads. It is not 
recommended to use this drive as the main storage area for your 
files. 

Personal Network Drive - H:1 drive 

The H:\  drive is your personal storage on a network server. Each 
user in the department has an assigned H:\  drive and is assigned 
100MB of space. H:\  drive is intended to serve as the primary 
location for personal information storage. It should contain only: 
• work in progress 
• personal working files 

) 	 • frequently referenced material not available elsewhere , 

You are solely responsible for managing and organising your 
own H:\  drive directories. You are responsible for sending 
corporate information to CATS, and for deleting material which 
no longer warrants retention. As users store more data on 
personal H:\  drives, the network drive eventually reaches full 
capacity. When this situation arises, you are required to remove 
inactive files from your H:\  drive. You do not have access to your 
H: \ drive when the network is down. 

13 



DFAIT SPECIFICS - INFORMATION MANAGEMENT

Shared Network Drive - I:\ drive

The I:\ drive provides a convenient medium for sharing
information and making contributions of interest to the division /
programme. The I: \ drive should be carefully managed and
organised to easily locate documents. When the I:\ drive reaches
its full capacity, you will be requested to remove inactive files.
Periodic review of the I:\ drive is recommended.

Using the I:\ drive

• The branch/bureau/division/programme sets out the "rules-of-
the-road" for the use of the shared workspace.

• Individuals are responsible for using the shared drive
according to accepted practices.

• Information stored on the I:\ drive must not be removed or
changed without permission of the individual or group who
placed it there.

• Personal work should not be stored in the shared network
drive. The A:\, D:\, or H:\ drives are recommended drives for
storing personal information.

• Contents and structure should be reviewed periodically and
files moved to more appropriate storage areas if necessary.

What Should be Stored on the I:\ drive

The I:1 drive is intended to be a storage space to share work-in

progress. It should contain only documents in progress such as:

• drafts which are not ready for "prime time",

• initial drafts of documents under group development

Advice and guidance on the organisation or structure of I:\ drive

information, including the use of filename conventions and

abbreviations, is provided by Information Managers.

I:\Corpinfo directory ?

The I:\corpinfo directory will no longer be available. All
information currently posted to I:\corpinfo will be accessible
through the Departmental Intranet.
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DFAIT SPECIFICS - INFORMATION MANAGEMENT 

What are Public Folders? 
=71 	Public folders facilitate workgroup collaboration in document 

production. Public folders are for storing and sharing working 
materials while they are in active use and storing duplicates of 
corporate records required by the workgroup on a regular basis. 
Public folders are common to both Headquarters and missions 
and are stored on local HQ or mission servers. 

What Should Public Folders Contain? 

Public Folders are not meant to be permanent storage facilities for 
departmental information. Final documents must be sent to the 
corporate records repository (CATS) for management and long 

_7;74 

	

	term storage. A copy of the final document may be retained 
within its subject folder for ease of reference and easy access. 

Public folders can contain but are not limited to: 
• drafts of documents that the group is finalising 

(collaboration); 
• discussions; 
• copies of frequently referenced information; 
• template documents; 
• address lists; 

iiii 	• staff lists; 
• staff meeting agenda and minutes; 
• work practices and procedures for the group; 
• organisational arrangements of the workgroup; 
• administrative information. 

Documents stored in public folders are not restricted to word 
processing documents. They can be spreadsheets, e-mail 

_.11) 	 messages or documents produced by any other application used 
within your workgroup. 

_:3 
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DFAIT SPECIFICS  - INFORMATION MANAGEMENT  

Planning 

Much like the I:\  drive, effective planning for public folders 
— 

requires an understanding of the public folder structure and usage. 

Your work unit should ensure a logical folder structure is in place 
as soon as you are able to create your hierarchy. You should 	 11.; 
begin by reviewing the suggested titles in the Departmental 
Subject Guide and Index and consulting your local Information 
Manager to determine appropriate Primary Subject titles and 
more specific Topic folder titles. 

The work unit (branch/bureau/division /mission/programme) 
should also establish some "rules of the road" in advance. Some 

2-  questions to consider in establishing standards and "rules of the 	 11.  

• Will your work unit adhere to the titles suggested in the 
depattmental subject index or will it establish a different 
structure? 

• Is anyone authorised to create new folders or will folder 
creation be a centrally located function? 11C2 

• Who will be the designated Moderator (manager) of the 
`L=  

Topic folders? 
• Who determines the access rights on folders? Will there be a 

standard for all folders in the workgroup or will the rights be 
determined as needed? 

1G= 
Public Folder Structure 

The Departmental Subject Guide and Index, representing 
depaitmental programme activities, provides the base for Main 
Subject and Primary Subject folder names. The subject index is 
derived from the corporate file classification system (RICS — 
Records Information Classification System) which also reflects 
the programme activities of the depaitment. There are seven 	 crz 
administrative programme subject folders and twenty-nine 	 Tr= 
operational programme activity subject folders. 

or: 16  
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DFAIT SPECIFICS - INFORMATION MANAGEMENT

Within the common structure, there are three distinct levels:

• Geographic Regions
• Work Location

• Subjects

The bilingual Main Subject folder names are derived from the
Departmental Subject Guide and Index, which relates to the
programme activities of the Department. All information is
stored in sub-folders below the Main Subject level.

For example:

Middle East / Moyen Orient

Tehran / Téhéran

Tel Aviv / Tel Aviv

OGD /AMF*

Subjects / Sujets

1-01 Administration / Administration
1-02 Communication / Communication
1-03 Finance / Finances
1-07 Property Management / Gestion Des Biens
1
2-05 Political Affairs / Affaires politiques
2 /
2-19 Environmental Affairs / Affaires environnementales
2 - /
2-37 TEAS Culture / SACE Culture
2-38 TEAS Services / SACE Services
9-99 Other Subjects / Autres Sujets**

* The OGD / AMF folder is available for government departments or
organisations at missions to organise and store information.

** 9-99 Other Subjects / Autres Sujets is meant to be a temporary repository
for information that may not fit into existing folder structure.

17
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DFAIT SPECIFICS - INFORMATION MANAGEMENT  

To access Help on using DFAIT Public Folders: 

1. Load Outlook. 
2. Click +Public Folders. 	 ti  

3. Click +All Public Folders. 
4. Click +? Help / Aide. 
5. Select DFAIT Subject Guide and Index or Organising 

Information in SIGNET. 

41 ;- 
CATS (Corporate Automated Text Storage) 

The Department has a legal requirement to collect and maintain 
government records. The Corporate Automated Text Storage 	 IL;-• 

(CATS) system is part of the corporate records management 
system. CATS allows for the storage, maintenance, retrieval and 	 1:7  
disposal of electronic documents that are either generated or 
received by the Department in the course of business. When 
sending mail messages, copying electronic document to CATS is 
equivalent to sending a paper document to file. CATS contains 
unclassified and Protected 'A' electronic documents. 

Sending documents to CATS 

The Corporate Automated Text Storage System (CATS) does not 
capture e-mail documents automatically. As a creator/originator 	 1-- 
of information, it is YOUR responsibility to CC CATS in mail 

1LT messages so they may be filed in the corporate database. (See 
CC CATS under Electronic Mail section of this Guide.) 

The following guidelines will help you determine what type of 
information is to be copied to CATS. 	 1-7  

What to send to CATS? 	 1L- 
Z= • original documents reflecting the substantive business of the 

Department 
• final versions of briefings, background notes, tallcing points, 	 11: 

reports, minutes of meetings, press releases 	 17; 
• final versions of instructions, statements, speeches 	 17: 
• most messages sent to Organisational Mailboxes messages 

 involving financial matters 
• messages involving legal matters 

18 	 17. 
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DFAIT SPECIFICS - INFORMATION MANAGEMENT

• documents that record how or why decisions and actions were
taken

• significant drafts of agreements or policy documents
• any other document that you feel should be part of the

corporate record.

Do not send to CATS

• messages that have already been copied to CATS
• not-ready-for-prime-time documents such as draft or trial

balloons
• e-mail messages that are equivalent of telephone message

slips or informal phone calls
• personal documents (e.g. appraisal reports, your resume,

notices to schedule a meeting, hockey pools etc.)
• arrangements, or personal messages not to be read by the

Department at large
• documents that are of no value to the corporate memory

Benefits of copying to CATS

Wherever possible, you should copy electronic messages to
CATS instead of printing and filing paper. With the exception of
electronic documents produced on SIGNET C4, do not send
both an electronic and paper copy of the same document to file.

Personal Information in CATS

Special care must be taken to ensure mail messages and
attachments containing personal information concerning
employees and clients is afforded the same degree of protection
as paper documents.

Help with CATS

If you are unsure whether or not to copy a document to CATS,
ask your Information Manager.

19



DFAIT SPECIFICS - INFORMATION MANAGEMENT

CATS on the Intranet

The CATS homepage and search engine is available to all users
from DFAIT's Intranet Homepage.

To access CATS on the Intranet:

1. Load Netscape.
2. From the DFAIT Intranet Homepage, click the CATS link.

To access CATS Help on the Intranet:

1. Load Netscape.
2. From the DFAIT Intranet Homepage, click the CATS link.
3. From the CATS homepage, click Help.

Retrieving Information from CATS

CATS provides all employees with instant access to unclassified
electronic records in the database. You can retrieve electronic
documents by searching for the originator, text in the subject line,
a date or date range or text in a message or attachment. For
security reasons, protected "A" information sent to CATS
through designated SIGNET (SIGNET-D) or classified
information, sent through Classified SIGNET (SIGNET-C4),
must be requested through a BICO or the SIGNET Call Centre.

To perform a simple search on CATS:

1. Load Netscape.
2. From the DFAIT Intranet Homepage, click the CATS link.
3. From the CATS Homepage, click Simple Search.
4. From the Simple Search window enter required keywords (see

CATS Help).
5. Click the Search button.

20



DFAIT SPECIFICS - ELECTRONIC MAIL 
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Switching from ICONDESK to Outlook — Survival Sheet 

ICONDESK feature 	 Outlook 

File / New Folder 	 File / New / Folder 

File/ Open Folder 	 Go / Go to Folder 

File / Browse 	 File / Open 

File / Archive 	 File / Archive 

File / Export 	 File / Import and Export 

File / Move 	 Edit / Move to folder 

File / Delete 	 Edit / Delete 

File / Close 	 File / Close 
File! Close all Items 

File!  Search 	 Tools / Find Items 

File / Print 	 File / Print 

File / Exit 	 File! Exit 

Edit / Cut 	 Edit / Cut 

Edit / Copy 	 Edit / Copy 

Edit / Paste 	 Edit / Paste 

View / Folder List 	 View / Folder List 

View / Inbox 	 Go / Inbox 

View / Outbox 	 Go! Sent Items 

View / Work 	 Go / Inbox (Outlook 97) 

Go / Draft (Outlook 98) 

View / Unread 	 View / Current View / Unread 
Messages 

21 



DFAIT SPECIFICS - ELECTRONIC MAIL 

ICONDESK feature 	 Outlook 

View / Outgoing 	 Go / Sent Items 
Tools / Find All / Messages from 
Sender 

View / All 	 Tools / Find Items 

Options / Alias 	 Tools / Address Book / File / 
New Entry 

Options / Message Options 	Tools / Options / Sending 

Options / List Layout 	 View / Current View 

Options / Order By 	 View / Sort 

Options / Tool Bar Layout 	N/A 

Options / Confirmation 	Tools / Options 

Options / Profiling / Mail 	Tools / Inbox Assistant 
Tools / Out of Office Assistant 

Options / Profiling / Print 	File / Page Setup / Define Print 
Styles 

Options / Toolbar 	 View / Toolbars / Standard 

Options / Status Bar 	 View / Status Bar 

Options / New after Send/Save 	N/A 

Options / Close after Send/Save 	N/A 

Options / Save Settings on Exit 	N/A 

Message / New 	 File / New / Mail Message 

Message / Extract Forward 	N/A 

Message / Forward 	 Compose / Forward 

Message / Reuse 	 Tools / Resend This Message 
(From a message window) 

Ii 

ii 
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ICONDESK feature Outlook

Message / Reply Compose / Reply
Compose / Re 1 to All

Message / Status File / Properties
(From a message window)

Message / Attachment Insert / File
(From a message window)

Message / Save File / Save
(From a message window)

Message / Send File / Send
(From a message window)

Message / Accept Tools / Check for New Mail

Attachment / Export File / Save Attachments

Corporate Automated Text Storage (CATS)

Departmental business is carried out continuously through mail
messages. Please CC those messages to the department's
Corporate Automated Text Storage (CATS). CATS is the first
address in the Global Address List. (More on CATS under
Information Management section in this Guide).

To CC CATS:

1. Prepare a new message.
2. Click the CC button.
3. Double-click CATS.
4. Click OK.
5. Complete and send the message.

Your ICONDESK Mail Messages

ICONDESK messages, which appear in Outlook's ICONDESK

Mailbox, are stored in a file called Icondesk.pst on your personal

network drive H:\. In order to have access to your old ICONDESK

messages it is important that Icondesk.pst remains on your H:\
drive.
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SIGNET 2000+ and ICONDESK users

SIGNET 2000+ users will continue communicating with
ICONDESK recipients until the end of 1999. Although mail
messaging will not be impaired during this period, consideration
should be taken when sending attachments to those recipients still
using old SIGNET applications.

Sending attachments to ICONDESK recipients

Once received in ICONDESK, the extension PVT replaces your
Outlook Mail attachments' filenames. To avoid any confusion,
send only one attachment per message to ICONDESK recipients,
carefully explaining in your message the content and format of
the file you are sending.

Attachments and software compatibility

If you send WordPerfect or Quattro Pro attachments to ICONDESK
users, please not the following:

• WordPerfect 8 files can be launched in WordPerfect 5..2/ 6.1
• Quattro Pro 8 files can be launched in Quattro Pro 6.0
• Quattro Pro 8 files cannot be launched in Quattro Pro 1.0

When sending a Quattro Pro 8 file to a Quattro Pro 1.0 user, you
will need to save your file in WB 1 format.

To save a Quattro Pro 8 file (*.WB3) to Quattro 1.0 (*.WB1) :

1. Load Quattro Pro 8.
2. Open the file to send as an attachment.
3. Select Save As form the File menu.
4. Click the File Type pull down menu.
5. Select Quattro Pro 1.0.
6. Click Save (you will have a WB3, Quattro Pro 8 and a WB1

Quattro Pro 1.0 versions of the same file).

SIGNET 2000+ long filenames and SIGNET-D users

Windows NT allows the creation of filenames of up to 255
characters. When exchanging files (e-mail or diskettes) with
SIGNET-D /(ICONDESK users, keep filenames to 8 characters.
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Sending large messages from Outlook Mail 
7 

Large messages (betvveen 1 and 5 MB) will be held until 6:00 
p.m. local time before they are delivered. Also, all messages 
larger than 5MB will not be delivered outside the user's local 
server. When in doubt check the size of a message before you 

7:11 	 send it. 

To check the size of a message before sending it: 

1. Prepare a New Message. 
2. From the File menu, choose Save. 
3. From the File menu, choose Properties. 
4. The size of the file is displayed after Size. 
5. Click OK. 

—1) 	Your ICONDESK Aliases 

ICONDESK aliases will have to be recreated in Outlook. However, 
Internet e-mail addresses contained in your ICONDESK aliases 

__111 have been saved in Alias.csv on your H:\  drive. To use these 
Internet addresses in Outlook you will need to import them as 
Outlook Contacts. 

To import Internet addresses created in ICONDESK: Ç. 

, 
" 

1. Load Outlook. 
2. Select Import and Export from the File Menu. 
3. Select Import from Schedule + or another program or file. 
4. Click Next. 
5. Select Comma Separated Values (DOS). 
6. Click Next. 
7. Click the Browse button. 
8. Select the H:\  drive. 
9. Select alias.csv. 

10. Click OK. 
11. Click Next. 
12. Select the Contacts folder. 
13. Click Next. 
14. Click Finish. 
15. You now have a Contact for each Internet recipient. 

_11 
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To send a message to an Internet recipient entered in your 
Contacts folder: 

1. Load Outlook. 
2. Right-click the Contacts folder. 
3. Select Properties. 
4. Click the Outlook Address Book tab. 
5. Click Show this folder as an e-mail Address book. 
6. Click OK. 
7. Prepare a New Message. 
8. Click the TO button. 
9. Select Contacts (under Outlook Address Book) in the address 

list pull-down menu. 
10. Double-click desired Internet recipients (will have e-mail after 

their name). 
11. Click OK. 
12. Complete and send the message. 

To type an Internet address in a recipient field Contacts folder: 

1. Prepare a new message. 
2. Click inside the TO field. 
3. Type name@server.domain. 

Example: jdoe@dfait-maeci.gc.ca . 
4. Complete and send the message. 

Your new Internet address on SIGNET 2000+ 

Your new Internet e-mail address on SIGNET 2000+ will begin 
with your first name, followed by your last name @dfait-
maeci.gc.ca . 

firstname.lastname@dfait-maeci.gc.ca , i.e. 
john.smith@dfait-maeci.gc.ca  

To send a message to an Organisational Mailbox: 

1. Prepare a new message. 
2. Click the TO button. 
3. Enter the name of the organisational mailbox (ex: Paris AG). 
4. Double-click the Organisational Mailbox. 
5. CC CATS. 
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6. Click OK.
7. Enter a message ID in the subject field composed of your

division symbol and a 4 digit number, followed by a dash,
followed by the subject:
Example: SXR1234-SIGNET 2000+ Organisational Mail
Example: LDNAG1234-Mission Training

8. Complete and send the message.

Locating OGD recipients in Outlook 98

The LDAP list contains all your OGD recipients and may be
accessed through Outlook 98's Address Book. For best results,
enter the recipients departmental acronym, followed by a:,
followed by a last name. Example: jus:smith, cida:brown. The
following is a list of OGD acronyms:

Acronym Name

ACOA Atlantic Canada Opportunities Agency
AECL Atomic Energy of Canada Limited
AGR Agriculture Canada
C&I Citizen and Immigration Canada
CAC Consulting and Audit Canada
CBSC Canada Business Service Centre
CCC Canadian Commercial Corporation
CCMD Canadian Centre for Management Development
CDNSA Canadian Space Agency
CED Canada Economic Development
CHRC Canadian Human Rights Commission
CICS Canadian Intergovernmental Conference Secretariat
CIDA Canadian International Development Agency
CIO Canada Information Office
CRTC Canadian Radio-television and Telecommunications

Commission
CSC Correctional Service Canada
CTA Canadian Transportation Agency
CWB Canadian Wheat Board
DFAIT Department of Foreign Affairs and International

Trade
ND National Defence-
EC Canadian Environmental Assessment Agency
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EC 	 Environment Canada 
ELECTC 	Elections Canada 
EPC 	 Emergency Preparedness Canada 
F&O 	 Fisheries and Oceans 
FCT 	 Federal Court of Canada 
FIN 	Finance Canada 
FJA 	 Commissioner for Federal Judicial Affairs 
GEMDES 	Gemdes 
HC 	 Health Canada 
HRDC 	Human Resources Development Canada 
IC 	 Industry Canada 
IDRC 	 International Development Research Centre 
INAC 	Indian and Northern Affairs Canada 
IRB 	 Immigration and Refugee Board of Canada 
JUS 	 Justice Canada 
NA 	 National Archives of Canada 
NB.GOV 	New Brunswick 
NISA 	Net Income Stabilisation Account Administration 
NJC 	 National Joint Council 
NLC 	 National Library of Canada 
NPB 	 National Parole Board 
NRCan 	Natural Resources Canada 
OAG 	 Auditor General of Canada 
HOC 	House of Commons 
PCH 	 Heritage Canada 
PCO 	 Privy Council Office 
PSC 	 Public Service Commission 
PSSRB 	Public Services Staff Relations Board 
PWGSC 	Public Works and Government Services Canada 
RC 	 Revenue Canada 
RCMP 	Royal Canadian Mounted Police 
SCC 	 Supreme Court of Canada 
SGC 	 Solicitor General Canada 
TBS 	 Treasury Board of Canada 
TC 	 Transport Canada 
TSB 	Transportation Safety Board of Canada 
VAC 	Veterans Affairs Canada 
WD 	 Western Economic Diversification Canada 
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To send a message to an OGD recipient:

1. Prepare a new message
2. Click the TO button
3. From the Global Address List pull-down menu, select LDAP
4. Click the Find button.
5. In the text field, type the departmental acronym, followed by

a : and the recipient's last name. Example: jus:smith.

6. Click OK.
7. Locate and double-click the desired recipient
8. Click OK
9. Complete and send the message

Faxing from Outlook 98

You may send faxes to MITNET and worldwide recipients using
Outlook 98. Please note that delivery reports for each fax
recipients will be sent to your Inbox. This means that a fax sent
to 1000 recipients through Outlook 98 will generate 1000
delivery reports messages in your Inbox. You may create a rule
in Outlook which will automatically store these messages in
another folder.

To create an Inbox rule to send all Fax delivery reports to a
specified folder:

1. Right-click your Mailbox and select New Folder.
2. Type Fax Delivery Reports for the folder name (or choose

another name), and click OK.
3. From the Advanced toolbar (View/Toolbars/Advanced), click

the Rules Wizard tool.
4. From the Rules Wizard dialog box, click New.
5. Select Move messages based on contents.
6. From the Rule description window, click specific words.
7. Type Fax to and click OK.
8. From the Rule description window, click specified folder.
9. From the Rules Wizard folder window, click the Fax Delivery

Reports folder created earlier and click OK
10. Click Next.
11.Ensure that with spec f c words in the subject of body is

checked and click Next.
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12.Ensure that move it to the specified folder is checked and click
Next.

13.Add an exception (not required) and click Next.
14.Enter a name for this rule, i.e. Fax Reports.
15. Ensure that Turn on this rule is checked and click Finish.
Once you have completed the above steps, all messages
containing Fax To (contained in each fax delivery report) will
automatically be stored in the Fax Delivery Reports folder.

To send a Fax message to Canada and US fax recipients from
any SIGNET 2000+ site in the world:

1. Prepare a new message.
2. Click inside TO field.
3. Type [FAX:name@lareacodefaxnumber]

Examples: [FAX:Jsmith@ 16139952000]

[FAX:JSmith@ 12125455656]

4. Complete and Send the message.

To send a Fax message to other fax recipients (except Canada
and US recipients) from any SIGNET 2000+ site in the world:

1. Prepare a new message.
2. Click inside TO field.
3. Type [FAX:name@0llcountrycodecitycodefaxnumber]

Examples: [FAX:JSmith@011331445566]

[FAX:JSmith@0113927774545]

4. Complete and Send the message.

To send a Fax message to a NIITNET recipient :

1. Prepare a new message.
2. Click inside TO field.

3. Type [FAX:name@MITNETfaxnumber]

Examples: [FAX:JSmith@3330101]
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4. Complete and Send the message. 

To create a distribution list for OGD recipients: 

1. Click the Address Book tool. 
2. Click the New Entry tool. 
3. Select Personal Address List. 
4. Click OK. 
5. Type a name for the Address List in the Name field. 
6. Click Add/Remove members tool. 
7. Select the LDAP list from the Global Address List pull-down list. 
8. Click the Find button. 
9. Type the department's acronym, followed by  a: and the 

recipient's last name. Example: jus:smith. 
10. Click OK. 
11. Locate and double-click the desired recipient. 
12. Repeat steps 8 to 9 until the list is complete. 
13. Click OK. 
14. Click OK. 
15. Close the Address Book. 

To create a distribution list of Fax or Internet recipients entered 
in Contacts folder: 

1. Load Outlook. 
2. Click the Inbox. 
3. Click the Address Book tool. 
4. Click the New Entry tool. 
5. Click Personal Address List. 
6. Click OK. 
7. Type a name for your list. 
8. Click Add/Remove Members. 
9. Select Contacts from the address list pull-down menu. 

10. Double-click desired Fax (Business Fax) or Internet (e-mail) 
recipients. 

11. Click OK. 
12. Click OK. 
13. Close the Address Book. 
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Managing Organisational Mail

Your organisational mail contains messages sent to your
divisional mailbox, i.e. -SXR, -PARIS, -LDN -AG etc. Messages

sent TO your divisional mailbox are ACTION messages.

Messages copied (CC) to your divisional mailbox are INFO

messages. ACTION messages should be forwarded to
appropriate recipients in your division. INFO and/or ACTION

messages should be circulated to the division on a daily basis.

Incoming organisational mail is stored in the Organisational
Mailbox's Inbox/Action or Inbox/Info folders and is

automatically copied to the ARCHIVE folder where it is kept for

90 days. Once messages have been in the ARCHIVE folder for

90 days they are automatically moved to the DELETED ITEMS

folder where they are kept for 30 days after which they are
permanently deleted.

To open your Organisational Mailbox:

1. Load Outlook.
2. Click your organisational Mailbox folder (ex: Mailbox-SXR).

To preview orgmail messages:

From the View menu, choose Autopreview.

To open an orgmail message:

Double-click a message in the Inbox.

To forward an Action message:

1. Open the message to forward.
2. From the toolbar, click the Forward tool.

3. Click the To button.

4. Select the desired recipient.
5. CC any required recipient(s).

6. Complete and send the message.
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To fonvard Action messages: 

1. From the Inbox, CTRL-Fclick all ACTION messages to 
forward. 

2. From the toolbar, click the .Forward tool (number of messages 
appear as icons). 

3. Click the To button. 
4. Select the desired recipient(s). 
5. CC any required recipient(s) including CATS if necessary. 
6. In the subject line, indicate that your are forwarding ACTION 

messages including the current date plus AM or PM if required. 
7. Complete and send the message. 
8. Repeat the above steps for all Action messages. 

To Print ACTION messages: 

1. From the Inbox, CTRL+click all ACTION messages to Print. 
2. From the toolbar, click the Print tool. 
3. Click Start each item on a new page. 
4. Click OK. 

Once ACTION messages have been forwarded or printed and 
distributed, delete them from your Inbox. 

To Delete ACTION messages: 

1. From the Inbox, CTRL+click all ACTION messages to delete. 
2. Press DELETE. 

To fonvard INFO messages: 

1. From the Inbox, CTRL-Fclick all INFO messages. 
2. From the toolbar, click the Forward tool (number of messages 

appear as icons). 
3. Click the To button. 
4. Select recipients from your division. 
5. In the subject line, indicate that your are forwarding your 

division's daily INFO. AM or PM circ pack. 
6. Complete and send the message. 
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To Print INFO messages:

1. From the Inbox, CTItL+click all ACTION messages to Print.
2. From the toolbar, click the Print tool.
3. Click Start each item on a new page.
4. Click OK.
5. Once INFO messages have been forwarded or printed and

distributed, delete them from your Inbox.

To Delete INFO messages:

1. From the Inbox, CTItL+click all ACTION messages to delete
2. Press DELETE

To search messages in the Archive folder:

l. Click the Archive folder.
2. From the Tools menu, choose Find Items.
3. From the Find dialog box click the Message Tab.
4. Enter words to look for in the Search for the word(s) field.
5. Click From and select recipient if looking for message from

particular recipient.
6. Click Sent To and select recipient if looking for message sent

to a particular recipient.
7. Enter any other required criteria.
8. Click Find Now.
9. Locate and open the message from the search results.

To restore a message from the Deleted Items folder:

1. Click the Deleted Items folder.
2. Drag the message to restore in the Inbox.

34



DFAIT SPECIFICS - DEPARTMENTAL CORRESPONDENCE

Departmental correspondence letterhead

You are no longer required to download fonts to the printer in
order to print departmental correspondence letterhead when using
DFAIT templates.

Create a letter using WordPerfect WP8 DFAIT Template:

1. Select File New.
2. Select DFAIT from the pull-down menu.
3. Select Letter.
4. Click Create.
5. Fill out the required fields (Tab forward, SHIFT+TAB back).
6. Select a letterhead.
7. Click OK.
8. Enter the text of the letter.
9. Save and Print.

Creating a memo using WordPerfect WP8 DFAIT Template:

1. Select File New.
2. Select DFAIT from the pull-down menu.
3. Select Memo.
4. Click Create.
5. Fill out the required fields (Tab forward, SHIFT+TAB back).
6. Select a letterhead.
7. Click OK.
8. Enter the text of the letter.
9. Save and Print.

Creating a fax using WordPerfect WP8 DFAIT Template:

1. Select File New.
2. Select DFAIT from the pull-down menu.
3. Select Fax.
4. Click Create.
5. Fill out the required fields (Tab forward, SHIFT+TAB back).
6. Select a letterhead.
7. Click OK.
8. Enter the text of the letter.
9. Save and Print.
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To access SIGNET 2000+ Corporate Applications: 

1. Click the Start button. 
2. Click SIGNET Network Apps. 
3. Click Corporate Applications. 
4. Select an application from the menu. 

To access HELP on SIGNET 2000+ Corporate Applications: 

1. Click the Start button. 
2. Click SIGNET Network Apps. 
3. Click Corporate Applications. 
4. Select HELP from the menu. 

To Add a Netvvork Printer: 

1. From the Start menu, choose Settings. 
2. Select Printers. 
3. From the Printer Folder double-click Add. 
4. From the Add Printer Wizard window, click Next. 
5. From the Connect to Printer window, select a printer from 

your site. 
6. Click OK. 

To Select a Default Printer: 

1. From the Start menu, choose Settings. 
2. Select Printers. 
3. From the Printer Folder double-click the printer to default to. 
4. From the Printer window, select Printer / Set as Default. 
5. Close the Printer window. 
6. Close the Printer folder. 
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Backing up Files

Make copies of files stored on your D:\ and A:\ drives. You never

know when a file may be unrecoverable either because of system

problems or human error.

To make copies of files on the D: drive:

1. Insert a diskette in the A:\ drive.
2. Click Start button.

3. Click Programs.

4. Click Explorer.

5. Click the + of the D:\ drive Icon from the Directory List.

6. Click the Directory to copy files from.

7. Select files to copy (CTRL+click).

8. Right-click the selected file or files.

9. Select Send to Diskette A:\.

To make a copy of a diskette:

1. Insert diskette with files to copy.

2. Click Start button.

3. Click Programs.

4. Click Explorer.

5. Right-click the A:\ drive from the directory list.

6. Select Copy Disk.

7. When prompted to insert the destination disk, insert New
diskette in A:\ drive, click OK.

Clean Up

Remember that the H:\ and I:\ drives are not boundless. There is

a limited amount of space available for files. Be certain to clean

up these drives by deleting documents which are no longer

essential.
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To Delete files on the H: drive: 

1. Click Start button. 
2. Click Programs. 
3. Click Explorer. 
4. Click the H:\  drive from the directory list. 
5. Select the file (files) to delete. 
6. Press DELETE. 

To delete files on the I:\  drive: 

1. Click Start button. 
2. Click Programs. 
3. Click Explorer. 
4. Click the I:\  drive from the directory list. 
5. Select the file (files) to delete. 
6. Press DELETE. 

To empty the Recycle Bin: 

1. From your Desktop, double-click the Recycle Bin Shortcut . 
2. From the File menu, choose Empty Recycle Bin. 
3. Click Yes. 
4. Close the Recycle Bin Window. 

Outlook Mailbox Limit 

SIGNET 2000+ users each have 100MG of space in their 
Mailboxes. In order to stay under this limit, avoid over 
formatting your mail messages (large fonts, attributes, colours). 
Also, keep mail folders manageable and delete messages you no 
longer need especially those with attachments. If you can't part 
with some messages, save them to diskettes. 

To check the size of your mailbox: 

1. Right-click your mailbox. 
2. Select Properties. 
3. From the Properties dialog box, click the Folder Size button. 
4. View the total folder size from the Folder Size window. 
5. Click Close. 
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- 

To delete Inbox messages: 
- 

1. Click Inbox folder. 
2. Select message or messages to Delete. 
3. Press DELETE. 

- 

- 

To delete Sent Items messages: 

1. Click Sent Items folder. 
2. Select message or messages to Delete. 

I _lb 	3. Press DELETE. 

To delete Deleted Items: 

1. Click Deleted Items folder. 
2. Select message or messages to Delete. 
3. Press DELETE. 

—e 	To empty the Deleted Items folder when exiting Outlook: 
I s 

1. From the Tools menu, choose Options. 
2. Click the Other Tab. 
3. Click Empty the Deleted Items upon Exiting. 
4. Click OK. 

Organise your Mailbox folders by creating sub-folders: 

Move messages you have read and wish to keep in a new folder 
rather than keeping them in your Inbox. Note that folders may 
also have sub-folders. 

To create a folder in your Personal Mailbox: 

1. Right-click your Personal Mailbox, click Create New Folder. 
2. Type the Folder name. 

I 	 3. Click OK. 
I '» 

To create one or more sub-folders in an existing folder in your 
Personal Mailbox: 

1. Right-click a folder, click Create New Folder. 
2. Type the Folder name and click OK. 
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File your messages before you send them:

1. Prepare a new message.
2. Click the Options Tab.
3. Select Save Sent Message To (the box must be checked).
4. Click Browse.
5. Click the Folder to place the current message in.
6. Click OK.

Deliver messages with large attachments later

Use the Do Not Deliver Before option (Options Tab in Message

window) to delay the transmission of large messages at non-peak
times.

To delay message delivery:

1. Prepare a new message.
2. Click the Options Tab.
3. Select Do Not Deliver Before radio button.
4. Select the Date.
5. Enter the time manually once date has been selected.
6. Complete and send the message.

Let others know when you are absent from the office by using
Outlook's Out of Office Assistant

When you are absent from the office and wish to let others know
who will be replacing you, activate the Out of Office Assistant.

To activate the Out of Office Assistant:

1. From the Tools menu, choose Out of Office Assistant.
2. Select I am Currently Out of the Office.
3. Type a message informing senders you will be out of the

office, your replacement, etc.
4. Click OK.
5. Exit Outlook.
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To turn the Out of Office Assistant Off: 

1. Load Outlook. 
2. At the prompt to Turn off the Out of Office Assistant, click Yes. 

—3 

Create distribution lists for frequently used e-mail addresses: 

1. Click the Address Book tool. 
2. Click the New Entry tool. 
3. Select Personal Address List. 
4. Click OK. 
5. Type a name for the Address List in the Name field. 

,11 	6. Click Add/Remove members tool. 
„ID 	 7. Type a first recipient's last name, press Enter. 
_ 	 8. Locate and double-click the desired recipient. 

,1) 	 9. Repeat steps 7 and 8 until list is completed. 
10. Click OK. 
11. Click OK. 
12. Close the Address Book. 

To send to a Distribution list: 

1. Prepare a new message. 
2. Click the TO button. 
3. Select your Personal Address Book form the Global Address 

list pull-down menu 
4. Double-click the desired Address List. 
5. Click OK. 

Departmental policy on using the Internet 

DFAIT provides all users of SIGNET 2000+ with access to the 
Internet and this privilege can be revoked if it is not used in a 
responsible and informed manner. 

SIGNET users may access the Internet through departmental 
facilities for work-related activities and career development. 

Personal use is allowed on personal time and must conform to the 
acceptable use policy, i.e. sending e-mail to colleagues and 
friends and exploring the Internet for useful information. 

41 ,11 

—3 



DFAIT SPECIFICS - BEST PRACTICES

Use of Government-owned media (such as diskettes or the hard
disk on your workstation) is not permitted when using DFAIT
Internet facilities for personal purposes.

DFAIT users are expected to access the Internet in a responsible
and informed way by learning about network etiquette, being
aware of computer security and privacy and guarding against
computer viruses.

Users should be aware that each site visited can be traced back to
the individual user and that the Department can monitor Internet
traffic to protect its reputation and guard against abuse.

Information accessed through the Internet is subject to laws
relating to intellectual property and users must respect the
copyrights claimed to all Internet data, including images and
software.

Users are expected to protect the safety of SIGNET and the
security and integrity of the Department's information by virus
scanning electronic files imported from the Internet.

Users must not share network or system passwords with anyone.

Users must exercise common sense and good judgement at all
times. Behaviour such as using DFAIT Internet facilities for
personal gain, commercial activities, visiting Internet sites that
contain obscene, hateful or objectionable materials is
unacceptable.

Users shall not use abusive or objectionable language in
messages or upload/download information or commercial
software in violation of its copyright.

DFAIT's Policy on Individual use of the Internet is available from
Netscape 4.0 Help Menu

To access DFAIT's Policy on Individual Use

1. Load Netscape 4.0
2. From the Help menu, choose Policy on Individual Use
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